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1 Current Version and History
1.1 New Functions
The following table lists the new functions and indicates the version in which the new
function was introduced:
New Functions in Software V1.61:
Version Function
V1.61

Support of ETL-K470 CDR (Convergent Digital Radio) License

V1.61

VSE-K70: Support of sub-option VSE-K70M for multimodulation analysis (requires separate
option key)

V1.61

VSE-K70: Support of sub-option VSE-K70P for bit error rate measurements with PRBS
(requires separate option key)

V1.61

VSE-K70: Support of new Bluetooth standards Bluetooth_5_LE_S2 and Bluetooth_5_LE_S8

V1.61

VSE-K70: The error vector trace can now be exported to an iq-tar file. This allows for carrierin-carrier measurements.

V1.61

VSE-K70: The maximum available I/Q bandwidth can now be queried with
TRAC:IQ:BWIDTh? MAX.

V1.61

VSE-K70: New SCPI command that allows for querying the capture length in symbols:
:SENSe:DDEMod:RLENgth:SYMBols:VALue?

New Functions in Software V1.60:
Version Function
V1.60

Support of Floating Licenses

V1.60

Support of VSE-K144 5G-NR Uplink&Downlink Measurements
(in line with TS38.211 15.2.0)

V1.60

Support for R&S RTP

V1.60

Support for *.wv files in the following applications:
I/Q Analyzer,K6, K7 ,K60,K72,K96, K100-K104,K106

V1.60

Support for:
FSW8, order no. 1331.5003K08,
FSW13, order no. 1331.5003K13,
FSW26, order no. 1331.5003K26, FSW43, order no. 1331.5003K43,
FSW50, order no. 1331.5003K50, FSW67, order no. 1331.5003K67,
FSW85, order no. 1331.5003K85

V1.60

I/Q Analyzer: Support for gating on I/Q files, including continued gate trigger with possibility
for a detailed specification of the gating pattern.

V1.60

I/Q Analyzer & options support I/Q data input:
For the input source “I/Q File” a repetition number is supported which determines how often
the data stream is copied in the I/Q data memory

V1.60

VSE-K106: New result “RB power excluding E-UTRA (dBm)” in result summary of downlink
inband mode. This result is necessary for calculating the “NB-IoT RB power dynamic range”
in 3GPP specification 36.141 chapter 6.3.3

V1.60

VSE-K544: Support of preview for selected file magnitude and phase, covered frequencies
and combined frequency response for I/Q mode

New Functions in Software V1.50:
Version Function
V1.50

Support of VSE-K544 Frequency Response Correction

V1.50

Supports Limit Line Import and Export using CSV (comma separated) files.

Version Function
V1.50

Support for FSW-B106

V1.50

Simple CSV and *.mat format is supported. See operating manual for details.

V1.50

IQ Analyzer: Support for Time Trigger on I/Q Files for ACLR and SEM Measurements

V1.50

VSE-K70: Increased precision for filter roll-off factor (Alpha/BT). Now three digits after the
decimal point can be entered.

V1.50

VSE-K70: Several new mappings (e.g. for 1024QAM and 4096QAM)

V1.50

VSE-K70: Support of I/Q skew measurement and compensation (only for PSK/QAM/Offset
QPSK)

V1.50

VSE-K70: Support of 64FSK

V1.50

VSE-K70: Support of new Bluetooth standards Bluetooth5_LE1M and Bluetooth5_LE2M

V1.50

VSE-K70: New mappings for 512QAM and 2048QAM.

V1.50

VSE-K96: Support of the SCPI command "INPut:ATTenuation:AUTO:MODE" which allows to
configure the optimization priority after the RF attenuation has been supplied.

V1.50

VSE-K96: It is now possible to configure the result units for EVM, Impulse Response, Symbol
Axes, Carrier Axes, Time Axes and Frequency Axes.

V1.50

VSE-K96: Added the possibility to configure the minimum time and frame synchronization
thresholds in the user interface.

V1.50

VSE-K96: The data displayed in the Constellation Diagram can now be filtered by clicking on
the label of the corresponding modulation.

V1.50

VSE-K96: Added the possibility to configure the size of the constellation points in the
Constellation Diagram.

V1.50

VSE-K96: The Configuration File Wizard now supports to configure two different cyclic prefix
lengths.

V1.50

VSE-K96: The Constellation Diagram now supports zooming.

V1.50

VSE-K96: The Constellation Diagram now supports markers.

V1.50

VSE-K96: Configuration files can now be loaded using "drag and drop".

V1.50

VSE-K100: Support of MIMO-measurements with simultaneous measurements of up to 4
input streams. This feature requires the VSE-K102.

V1.50

VSE-K100: Support of SCPI command
TRACe<n>:DATA:X? TRACe1 | TRACe2 | TRACe3
For reading out the X-values of result diagrams in the EVM-measurement.

V1.50

VSE-K100: For measuring EUTRA-carriers with an embedded NB-IoT carrier, the NB-IoT
carrier can now be cut out so that the analysis of the EUTRA -part of the signal is possible.

V1.50

VSE-K106: Suppport of Multi Frame Capture in downlink

V1.50

VSE-K106: In downlink in-band-mode, all possible offset to the E-UTRA carrier can now be
selected from a list

New Functions in Software V1.41:
Version Function
V1.41

Support for R&S ZNL, requires ZNL-B1

V1.41

Support for VSE Basic Edition (Order No. 1345.1011. 06) and VSE Enterprise Edition (Order
No. 1320.7500.06). The R&S VSE Enterprise Edition and Basic Edition differ in the number of
channels, groups, and instruments that you can configure at the same time:
Supported
number of

Enterprise
Edition

Basic
Edition

Instruments

128

1

Groups

30

1

Version Function
Channels

V1.41

30

3

New SCPI command to load a single IQ File into multiple channels at once.
INSTrument:BLOCk:FILE<fi>:MAT
INSTrument:BLOCk:FILE<fi>:IQW
INSTrument:BLOCk:FILE<fi>:IQTar
INSTrument:BLOCk:FILE<fi>:CSV
Only available for VSE Enterprise Edition

V1.41

New SCPI Command command to load a single IQ File into a channel without reprocessing
the meta information like sample rate etc.
INSTrument:BLOCk:FILE<fi>:REPLace <FileName>
Only available for VSE Enterprise Edition

New Functions in Software V1.40:
Version Function
V1.40

Support for FSW-B2001

V1.40

Support for VSE-K96 OFDM VSA

V1.40

Support for R&S FPL

V1.40

Analog Baseband Support with RTO1000 and RTO2000 series

V1.40

Support of external and IF-Power Trigger for FSW-B1200

V1.40

Update of R&S Visa to Version 5.8.2.

V1.40

Support for 20GHz sampling rate when using RTO in Waveform mode

V1.40

VSE-K70: Start of the current result range within the capture buffer can now be queried with
sample precision by [SENSe:]DDEMod:SEARch:MBURst:STARt:SAMPles?
VSE-K70: All eye diagrams support two horizontal and two vertical display lines, which allow
a manual measurement of the eye size (Limits -> Vertical/Horizontal Line …).
VSE-K70: Predefined display configurations are offered for e.g. PSK/QAM signals and FSK
signals (File -> Preset-> Predefined Display…)

V1.40

K6: Increased pulse analysis limit to 200,000 pulses

V1.40

K100/104: The parameter Channel Estimation can now be set to Off, which deactivates the
equalizing filter.

1.2 Modified Functions
The following table lists the modified functions and indicates the version in which the
modification was carried out:
Modified functions of Software V1.61:
Version Function
V1.61

VSE-K70: The "reset equalizer" button is now only active if the equalizer is in "Tracking" or
"Averaging" mode.

V1.61

VSE-K70: Symbol errors that are detected in a bit error rate measurement are not highlighted
with a red frame anymore, but are displayed in red text within the symbol table.

V1.61

VSE-K70: The menu entry "Digital Standards" has been moved from "File"->"Preset" to
"Meas Setup"

V1.61

VSE-K70: PSK/QAM constellations are now always normalized to an RMS value of 1. This
may lead to a different scaling of the results based on the measurement or reference signal,
e.g. the I/Q constellation diagram.

V1.61

VSE-K70: The bit error rate result table can now be open, even if the bit error rate
measurement is not active.

V1.61

VSE-K96: The result length can now be set automatically whenever a new configuration file is
loaded. Whenever the parameter <DefaultResultLength> exists in the <GeneralParameters>
group, this parameter is used as result length.

Modified functions of Software V1.50:
Version Function
V1.50

The query answer string of *OPT? is now always terminated with a ‘comma’ to simply string
comparison.

V1.50

Online Help stays visible while VSE is in Remote Mode. Help Windows can no longer be
docked into the main application window,

V1.50

VSE-K70: For very large capture oversampling rates (≥ 64), a lower number of display points
per symbol (i.e. 32) is now used by default to avoid prolonged display times and extremely
large amounts of trace data.

V1.50

VSE-K70: Increased limit for maximum burst length (upper limit now equal to the limit for the
result length)

V1.50

VSE-K70: The bit error rate result is now displayed in scientific format.

V1.50

VSE-K96: Increased maximum number of different constellation types within one
configuration file to 63.

V1.50

VSE-K96: Increased maximum number of OFDM cells that can be analyzed from 1500000 to
6144000.

V1.50

VSE-K96: Carriers at the edges of the spectrum that contain only "Don't Care"-cells are no
longer used in the channel estimation.

V1.41

VSE-K106: Extended F_offset for SEM measurement to +/- 200 kHz in case of standalone
distribution according to table 5.6-3A of 3GPP of document 36.141 revision 14

Modified functions of Software V1.41:
Version Function
V1.41

Input "Baseband Oscilloscope" renamed to "Oscilloscope Baseband" for harmonization with
other products.

Modified functions of Software V1.40:
Version Function
V1.40

VSE-K70: FSK Ref Deviation can now be set to 60 * Symbol Rate (15 * Symbol Rate before)

Version Function
VSE-K70: The maximum number of “Display Points/Sym” for all result windows is now limited
to 32 (exceptions: Result Summary and Capture Buffer Displays)

1.3 Improvements
The following tables list the improvements and indicate since which version the issue
could be observed:
Improvements of Software V1.61:
since

Function

V1.50

VSE-K70: Remote commands INP:IMP? and INP:IMP:PTYP? did not work. This issue is
solved.

V1.40

VSE-K70: “Meas only if Pattern Symbols Correct” functionality did not work for short patterns.
This issue is solved.

V1.30

VSE-K10: When using EDIT COPY TO CLIPBOARD to transfer the results of TRANSIENT
SPECTRUM TABLE or MODULATION SPECTRUM TABLE the limit check verdict was
always shown as FAILED. This issue is solved.

V1.50

VSE-K96: After recall, Cyclic Prefix and Preamble settings were sometimes overwritten by the
content of the configuration file used. This no longer happens.

V1.50

VSE-K96: After loading an I/Q file, the capture length is now always automatically set to the
length of the I/Q file content.

V1.50

VSE-K96: Loading the same XML file twice no longer leads to unloading the OFDM
configuration.

V1.50

VSE-K96: Markers are now also transferred to new channels when using the "Duplicate
Channel"-functionality.

Improvements of Software V1.60:
since

Function

V1.50

I/Q Analyzer: During I/Q Vector ASCII Trace Export, the I-values were sorted in ascending
order. This issue is solved and these values are not sorted anymore.

V1.50

VSE-K106: Controls for "E-UTRA CRS Sequence Info" and "E-UTRA PRB Index" were
corrupt and no value could be selected. This issue is solved.

Improvements of Software V1.50 SP2:
since

Function

V1.50

VSE software occasionally crashed if the I/Q input file was replaced for all channels of a
channel group. This issue is solved.

V1.50

VSE software crashed when SCPI commands were sent in a very quick succession. This
issue is solved.

V1.30

When loading .iq.tar input files the VSE software could crash under rare circumstances. This
issue is solved.

V1.50

VSE-K91: Improved auto level functionality for WLAN signals with low duty cycle.

Improvements of Software V1.50 SP1:
since

Function

V1.50SP1 VSE-K96: In some cases the Capture Time was not recalled correctly when loading a saveset
in which multiple VSE-K96 measurement channels were open.
This issue is solved.
V1.50

VSE-K96: If the Stop Time in the Player gets increased above the maximum Capture Time
that is allowed by the VSE-K96 signal processing, the limits for the K96 Capture Time setting
are not set correctly. This can lead to a state in which a higher Capture Time can be

since

Function
configured than can actually be processed. In this case the displayed results are calculated
on a shorter capture time than configured. The actually used capture time is displayed on the
Magnitude Capture display
This issue is solved

V1.50

Maximum Frequency was incorrectly limited to 26.5GHz when YIG Preselector was active.
This issue is solved

Improvements of Software V1.50:
since

Function

V1.10

VSE-K70: File input can now be selected by INP:SEL FIQ

V1.10

Entering an option key code manually lead to a lock up of the firmware. Nevertheless the key
code was working fine after a reboot. This issue is solved.

V1.10

The I/Q Swap setting was not restored when loading a saveset. This issue is solved

V1.10

The external reference setting was temporarily reset when loading a saveset. This issue is
solved

V1.10

VSE-K70: “Meas only if Pattern Symbols Correct” functionality did not work for short patterns.
This issue is solved.

V1.40

VSE-K96: When creating multiple VSE-K96 channels using the "Duplicate Channel"
functionality or when loading a saveset with multiple VSE-K96 channels, the sample rate was
not applied to all channels. This issue is solved.

V1.40

VSE-K96: When using "Baseband Oscilloscope" as input source, the deskew-button did not
work. This issue is solved.

V1.40

VSE-K96: The positions of the Cyclic Prefix lines in the Impulse Response result display are
now updated when changing the "FFT Shift relative to Cyclic Prefix Length" setting.

V1.40

VSE-K96: The ideal constellation markers are now also available when using symbolwise or
carrierwise modulation detection.

V1.41

VSE-K100: A logfile including an error message was created in C:\Temp in case that the
synchronization failed. This problem is solved.

Improvements of Software V1.40:
since

Function

V1.10

VSE-K70: File input can now be selected by INP:SEL FIQ

1.4 Known Issues
The following table lists the known issues and indicates since which version the issue
could be observed:
since

Function

V 1.50

LTE MIMO in combination with K544 results in an incomplete measurement. The capture
doesn’t finish.

V 1.05

IQ Vector display can slow down VSE when choosing a long record length

V 1.10

K6: The following commands are not available:

[SENSe:]FREQuency:CENTer:STEP
V1.10

Saving and Recalling Matlab Files (*.mat) only supports ASCII compatible File names unless
activated in windows.
In order to allow Unicode characters in file names, make sure to enable support for 8.3 file
names on the drive(s) the file is being read from or exported to. For more information please
refer to this MSDN:
https://support.microsoft.com/de-de/help/121007/how-to-disable-8.3-file-name-creation-onntfs-partitions

The following table lists known issues with supported instruments and additional
Software:
Function

Instrument
/ Software

FW/SW
Version

VSE-K100/104: Using the current FSV or FSW Firmware the
Frame Start Offset calculation has an accuracy of less than +/100ns with the current FSV and FSW Firmware

FSV

all

K72: Using the current FSV or FSW Firmware the Trigger to
Frame calculation has an accuracy of less than +/- 100ns

FSV

The Auto Level doesn’t finish when connected with an RTO.

RTO

FSW
all

FSW

The Reference Level Setting doesn’t work reliable

FW 2.6x.x
FW 2.7x.x,
FW 3.4.x.x

The VSE Software will stop working at random when visa
packages from different vendors are installed in parallel on the
PC. Removing the ambiguity solves this issue.

Any VISA

Using the R&S Visa (V5.5.4.0) can cause the R&S VSE to stop
R&S VISA
measuring IQ data. The issue was observed using the Waveform
Mode of the RTO (default in VSE-K6) or with high traffic on the
LAN connection.

1.5 Modifications to the Documentation

5.5.4.0

2 Software Installation
The software installation file for the R&S VSE is one file including the main version
number e.g. VSESetup_V1.30.exe. It will be referred to as VSESetup.exe later in the
text. The file can be found on the Rohde & Schwarz web page.

The R&S VSE can only be installed on the 64 Bit Version of Windows 7 or
Windows 10

2.1 Installing the Software on your PC
Performing the installation on your PC:
The R&S VSE needs some additional software components to run properly.
The following components are needed:
●
●

Microsoft .NET Framework Version 4.0
VISA (Virtual Instrument Software Architecture)

Install Microsoft .NET Framework
The R&S VSE installer will try to install the .Net 4.0 from the internet.

Install VISA
It is necessary to install VISA (Virtual Instrument Software Architecture) to access
instruments connected to the PC via IEEE or LAN bus.
Please use the R&S VISA provided with the VSE installer or visit www.rohdeschwarz.com/rsvisa to get the latest version

Installing VSE
Please save the VSE Installer on your hard disc in order to install the Software

2.2 Installing Software Options
2.2.1 Software options included in base software
The K7 application software package is included in the base software. Therefore, it
does not have a separate item in the installer to be selected.

2.2.2 Other Firmware Options within the VSESetup.exe File
General VSE Options
The R&S VSE-K70 and other application software packages have their own installation
item and are therefore added to the selection list during the software update. Ensure
that the checkboxes are checked  if installation is requested.

ETL-K470 CDR License
The Convergent Digital Radio (CDR) feature available in the R&S VSE requires an
Ethernet connection to an R&S ETL. The R&S ETL must have a valid R&S ETL-K470
CDR license and a firmware version 3.51 or later.
To use the R&S ETL CDR, you have to install the following R&S VSE packages:
●
●
●

R&S VSE Vector Signal Explorer software
R&S VSE K96 OFDM signal analysis
Activate R&S ETL-CDR K470

When you activate the R&S ETL-K470, R&S VSE runs in an exclusive CDR mode.
CDR mode is designed to analyze CDR signals within the VSE. Therefore, it has the
following restrictions:
●

●
●

You can only use the I/Q analyzer and the OFDM analysis for CDR signals. Using
other (optional) applications is not possible, even if you have a valid license for
them (for example on an R&S FSPC dongle).
You can only connect to an R&S ETL. Connecting to other instruments otherwise
supported by the R&S VSE is not possible.
You can only connect to one R&S ETL at a time.

2.2.3 Enabling Options by Entering Option Key Codes

This section can be skipped if the option key was entered once.
To activate application software packages, you must enter a license key for validation.
If a XML-file with an option key was sent to you see the install description below.
The license key is in the device certificate or delivered as a part of the software
package. The process is performed in the following steps:

1.

Go to the "Help" menu

2.

Press the "License" menu item.

3.

Press the "Install Option" Button
A dialog box is displayed.

4.

Enter the option key number.

5.

Press "ENTER".
After a successful validation the message "Option Key valid" is displayed. If the
validation failed, the option software is not installed.

6.

Restart the software.

Installation of options via XML-file
1.

Go to the "Help" menu.

2.

Press the "License" menu item.

3.

Press the button "Install Option by XML" button.
A file browser is displayed.

4.

Select the path to the XML file (e.g. network drive or USB stick).

5.

Press "Select".
After a successful validation the message "Option Key valid" is displayed. If the
validation failed, the option software is not installed.

6.

Reboot the device.

3 Customer Support
Technical support – where and when you need it
For quick, expert help with any Rohde & Schwarz equipment, contact one of our
Customer Support Centers. A team of highly qualified engineers provides telephone
support and will work with you to find a solution to your query on any aspect of the
operation, programming or applications of Rohde & Schwarz equipment.
Up-to-date information and upgrades
To keep your software up-to-date and to be informed about new application notes
related to your software, please send an e-mail to the Customer Support Center stating
your software and your wish. We will take care that you will get the right information.
Europe, Africa, Middle East
Phone +49 89 4129 12345
customersupport@rohde-schwarz.com
North America
Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com
Latin America
Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com
Asia/Pacific
Phone +65 65 13 04 88
customersupport.asia@rohde-schwarz.com
China
Phone +86-800-810-8828 / +86-400-650-5896
customersupport.china@rohde-schwarz.com

